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Introduction

WebThing is a full-featured HTML editor and workshop. With WebThing, you can:

· Create Web pages and preview them on all available browsers.
· Interactively edit Web page resources and appearance.
· Import full-featured text, tables and outlines into your Web page, with table structure,

 indentation, font color, size and face preserved.
· Create interactive forms that launch programs to do things not possible in HTML alone.
· Organize a set of Web pages and associated graphics, sound files, and other resources.
· Maintain Web pages by examining their mutual references.

WebThing will help you get started if you are a beginner, and it will help you organize larger 
projects as you acquire more experience. WebThing will automatically copy resource files to 
your working directory as you select them, and will alert you if there are resources that are no 
longer being used.

WebThing supports many of the HTML tags currently in use, and can be customized to include 
any specialized tags that the user desires, and any new tags that come into use in the future.

These help pages cannot teach you all you need to know about HTML to be a successful Web 
page writer, but there are many sources of detailed information that you should access. One very 
effective way to learn about HTML and Web pages in general is to browse the Web. There you 
will see any number of well-designed Web pages.

Another way to get more information is to search the Web itself for information about HTML. 
Example: Get online and access the Yahoo search engine at http//www.yahoo.com. Type HTML 
as your search string. Another good search engine is http://www.lycos.com. Also, bookstores and
libraries have many excellent references on HTML.

These pages will help you with the particulars of WebThing and its special features, and contain 
some instructions on the use of the most common HTML tags.



The Internet and the Web

Computer networking has had a short and spectacular history. From the first effort to connect 
two computers together in the 1950s (rumor has it they deadlocked each other with "syntax error 
in line 12" messages) to the present, the value of sharing computer resources has become 
obvious. Regional networks became connected to each other, and eventually the Internet came 
into being.

There was always some way to navigate from place to place on networks. Earlier systems 
required you to type something cryptic at a keyboard, and to know something about Unix. As 
time passed and more people tried to use the Internet for more kinds of things, the old ways were
replaced with more intuitive graphic interfaces.

The most popular present method to interact with the Internet is by way of a Web Browser, a 
program that can read Web Pages that have been posted on the Internet. A modern Web page is a 
multimedia resource, containing text, images, sounds, and animations. Soon Web pages will 
contain links to objects that will offer you access to resources such as programs and information 
in ways not presently possible.

The "Web" in "Web page" refers to The World Wide Web, which is not so much a network as a 
way to interact with a computer network. The Web is in fact a combination of communication 
protocols that include a language called HTML, several kinds of programs called Browsers, and 
the Internet to connect it all together.

"Web pages" are written in HTML using a program like this one, generically known as a "Web 
Page Editor." After being written, Web pages are usually posted on a computer that is attached to 
the Internet. Then people who have network access to that computer can "read" the web page 
using their browser program.

Some Web pages contain graphics, sounds, and other things to increase their information content 
(translate: fun). But the most important single thing about a Web page is that it can contain links 
to other pages, resources, and locations. The behavior of these links is referred to as Hypertext, a 
method by which one can jump from place to place by activating the links.

In the original embodiment of Hypertext, one would move from paragraph to paragraph in a 
document using links, as in this help page. Now, using HTML, one may move from country to 
country by clicking a pointer device.

Individuals and institutions are therefore very interested in creating Web pages in the easiest 
possible way, and that is why WebThing was written -- to make it easy to create your own Web 
page, add to it, and maintain it.

A good way to start is to browse the Web and see some of the pages that have been written by 
others, to get ideas about how you would like your page to look. Most browsers allow you to 
examine the original HTML code to see how a particular effect was created. This is a good way 
to learn advanced techniques.





The Basics of Web Pages

In the simplest terms, the World Wide Web is a collection of web pages and other resources 
located on Internet server computers connected to web page browsers located on individual 
machines also connected to the Internet. What makes it a Web is that the Web pages 
communicate the information desired by their authors, and also they connect readers to other 
resources by way of links. The links in Web pages can refer to another Web page, a program, or 
some other kind of file, or another way of interacting with the Web such as Telnet.

Web pages have two aspects. One aspect is how the page looks to a web browser, colorful and 
interactive. The other aspect is the actual HTML code that tells the browser what to do. The fun 
part of browsing is seeing the result aspect, but the other part, the code, has to come first.

Fortunately, HTML was designed to be as obvious as possible, consistent with its purpose. You 
will be writing HTML in a very short time from starting out. Writing great HTML code will take 
longer.

The overall process for creating a Web page is to get the resources together -- a web editor 
(you've already taken care of that) and a browser. If you don't already have a Web browser, I 
recommend Microsoft Internet Explorer. It is available on the Internet (possibly a catch-22 if you
don't have any browser right now) and, like WebThing, it is free (but see the CareWare section 
for a better explanation of "free").

Once you have these basic tools, you can follow this strategy:

· Make a plan. Perhaps you want to have just one page that says "Hi, world, this is me!", or
perhaps you want to create something more ambitious, several pages, lots of graphics. A broad 
outline of your intentions is a good starting point.

· Select a data directory to store your work as it proceeds. WebThing will prompt you to do
this the first time you create a link between two file resources.

· Create the first page (if you are planning more than one). This page is usually the first 
thing a visitor sees, and is often no more than a table of contents. Usually this page is named 
"index.htm" to be consistent with how Internet servers locate and activate pages.

· Create the child pages, and link them to the index page. As you work, launch your Web 
browser (WebThing allows you to do this while you work) to see the result of your efforts.

· Finally, after testing all the pages and jumping between them and to any outside resources
you reference, you can upload your page(s) to the Internet. This is in some ways the most 
specialized part of the process, and you may have to ask your Internet Service Provider for help.

WebThing has many features to simplify this process. WebThing will remind you to set up a 
working directory, then it will ask whether you want to automatically copy resource files to this 
directory as you work. Using this feature, you will automatically assemble all the resources for 



your Web page in one place, and you will also use what are called "relative links" to them, 
meaning the entire package will work as expected after being moved onto the Internet server. 
And, using a cross-reference feature, WebThing will find and list resources files that are no 
longer being used by your pages, for easy removal.

With WebThing and a browser installed on your system, you can develop web pages without 
actually being connected to the Internet. You can write, test, debug, and modify your pages 
before posting them on the Internet. And, perhaps best of all, you can add your favorite tags to 
WebThing, tags you use a lot, or tags that don't exist as this is being written.



The Basics of HTML

The most important thing to realize about HTML is that it is changing with time, and that 
different browsers support different features. Therefore, if you want to be a serious Web page 
developer, you should collect enough browsers to be sure your page looks acceptable on all of 
them. WebThing supports up to six browsers simultaneously, allowing you to verify changes as 
you work.

The next most important thing to know about HTML is that it was designed to be as easy and 
transparent as possible. After a short time, you will be able to look at an HTML script and predict
more or less how it will look when viewed with a browser. Naturally, WebThing does not require
you to guess -- you can just press a button to move between the HTML code display and the 
browser display.

The most basic element of HTML is called a "Tag." HTML tags usually, but not always, come in 
pairs, an opening tag and a closing tag.

Tags are enclosed in the greater than - less than symbols "<" ">."

The opening tag of a pair of tags appears this way: <TAG>.

The closing tag of a pair appears this way: </TAG>. Notice the slash.

Tags can contain modifiers within the "<" ">" symbols. Example: <IMG SRC="myimage.gif">
The information inside the tags tell the browser to do something. Example: <BGSOUND 
SRC="music.mid"> tells the browser to play some music (if the browser in question is Microsoft
Internet Explorer).

The information outside the tags is printed as text. Example: the HTML code "This should be 
<B>Emphasized</B> more than usual." will be shown by the browser as "This should be 
emphasized more than usual.

In this example, the browser understood the <B> tag to mean "start printing in boldface." The 
browser then took the </B> tag to mean "go back to the previous state." Most HTML tags are 
nested, which means they add to the formatting of any prior tags, even if the prior tags specify 
the same thing. This example of HTML:

"This is <B>an <B>important</B> point</B> to make."

Would most likely be rendered as:

"This is an important point to make."

because each pair of tags independently affect the text, and when the closing tag appears, the 
browser simply returns to whatever formatting had existed previously. This is important to 
understand and can save you from mysterious behavior in your Web pages.



NOTE: These structural issues are important to understand, but WebThing will automatically 
convert text with many different styles, fonts, and colors for you, either by dragging text from 
another application to the Drag & Drop Mailbox, or by saving files in Rich Text Format, then 
importing them into WebThing. Web Thing will automatically convert formatted text, tables, and 
outlines (indented structures) into the appropriate HTML code, as much as possible preserving 
the original appearance of your text (within the constraints imposed by HTML).

The most basic HTML document looks like this:

<HTML>

<Head>
<Title></Title>
</Head>

<Body>

</Body>

</HTML>

These pairs of tags are regarded as the basic structure of an HTML page, and all existing 
browsers support it. WebThing will automatically create this structure for you when you open an 
HTML document from the File menu, or use the Structure/Lists toolbar.

The <HTML></HTML> tags simply identify this as an HTML document. The 
<Head><Title></Title></Head> tags basically allow you to place a title inside your document. 
This title is normally not displayed by the browser as part of the page, but appears at the top of 
the browser display on its title bar, and is also accessed by Internet search engines for descriptive
information about your page.

Most Web Page development takes place within the <Body> </Body> tag pair. For example, if 
you typed "This is my page" between the <Body> and </Body> tags, your browser would 
display that phrase.

There are many structural elements in HTML, such as tables, lists, and provisions for graphic 
images and other resources, but by far the most important to understand is the Hyperlink or link.

The most common HTML link looks like this:

<A href="destination">An interesting place</A>

The browser will show this link as An interesting place and if you click on it (in a browser), the 
browser will locate and load the thing described by "destination". In creating a link, the text you 
type between the <A> and </A> tags tells the reader what the link is, and the href="destination" 
part of the link tells the browser where to look for the resource.



Links are the way you navigate around the World Wide Web. A link might contain another of 
your own pages:

<A href="mystory.htm">Click here to read my story</A>

A link might refer to another location in the same Web page

<A href="#somebookmark">Click here to move to the bookmark</A>

Elsewhere in the Web page would be the name to which this bookmark refers, and to which the 
browser would move:

<A name="somebookmark">Thanks for coming around!</A>

A link can refer to a file you want to allow access to:

<A href="myprogram.exe">Click here to run my program</A>

Or:

<A href="database.mdb">Click here to download my data file</A>

And (actually a very common example) you can refer to something else on the World Wide Web:

<A href="http://www.microsoft.com">Click here to visit Microsoft</A>

You can also place a graphic image on your page:

<IMG SRC="myhouse.gif>

You can even use a graphic image as the clickable area for a hypertext link:

<A href="http://www.beachstuff.com"><IMG SRC="sandybeach.gif>
</A>

In this example, the visible part of the tag is a picture instead of text. When the user clicks on the 
picture "sandybeach.gif", the browser jumps to the Web location identified by 
"http://www.beachstuff.com".

Hypertext links can refer to many kinds of things, including files, Web sites, locations in the 
same document, other pages you have written, they can even launch applications and send E-
mail.

This is just the barest outline of what HTML can do. Once again, there are many resources 
available that can provide a full description and use of HTML, including resources on the Web 



itself.



How to Create Your Own Page (Tutorial)

Now we will create a small, easy Web Page, just to get your feet wet. At this point you should 
have installed WebThing on your computer, have an icon available to run WebThing, and be in a 
somewhat adventurous frame of mind.

(If this is hard to follow the first time, you might want to print this help screen so you don't have 
to keep referring to it on the computer screen.)

Go ahead and run WebThing, and select File … New HTML Document. A new document will 
appear on the screen, and a dialog box will appear with some choices. Just to keep this simple, 
for now just press "OK" to go on.

This document outline will appear on your screen:

<HTML>

<Head>
<Title></Title>
</Head>

<Body Background="" BGColor=#FFFFFF Text=#000000 Link=#0000FF VLink=#FF00FF 
ALink=#FF0000>

|

</Body>

</HTML>

The vertical bar '|' above represents the location of the cursor in the WebThing editor screen. 
Now type "This is my first Web Page!" and then press the preview button, the toolbar button that 
looks like this:

  

If you don't see your Web Page displayed, then a word of explanation is in order. When 
WebThing runs for the first time, it looks around in your system for useful information, like 
whether Windows knows the whereabouts of a browser. If there is such a browser, WebThing 
will use it to show your page.

If Windows doesn't know the location of a browser, WebThing will ask you to locate one for it. If
you actually don't have a browser on your system, you should stop this exercise, acquire one, and
continue. There are several good ones posted on the web (a possible catch-22 situation if you 
don't already have a browser with which to look for it) and some are free.

If you do have a browser that Windows doesn't know about, simply tell WebThing its location, 
and our little exercise can continue.



When you are done admiring your handiwork as displayed by your browser, just exit the browser
and WebThing will reappear.

Now let's experiment. I can't know what your background is or how much you know about 
computers, so you may choose to take each of these steps, or skip ahead if you wish.

Drag the mouse across the word "first" to select it, so the display looks like this:

This is my first Web Page!

(note: the text shown in color here will look white-on-black on the WebThing editor screen, i.e. 
selected)

Now press the toolbar button that looks like this:

This button will make the selection bold, just like in a normal word processor. The WebThing 
display will look like this:

This is my <B>first</B> Web Page!

Remember: all formatting in the HTML language is by way of tags. You won't see the bold effect
until you click the preview button on the toolbar and let the Browser display the result of your 
changes.

Now let's choose some more interesting colors for the display. Use your mouse to position the 
cursor as shown below:

<Body Background="" BGColor=#FFF|FFF Text=#000000 Link=#0000FF VLink=#FF00FF 
ALink=#FF0000>

Notice the vertical bar in the middle of "BGColor=#FFF|FFF". This time, don't select anything, 
just position the cursor as shown. Now press the right-hand mouse button. A dialog box will 
appear asking you to select a color. Choose a color you like for a background. Now position the 
cursor in the middle of " Text=#000|000" and make a selection in the same way.

Now press the preview button again and look at the colors you have chosen. You can experiment 
until you are satisfied with your colors. You will notice that, if you have selected any of the text 
in the document and then click the right mouse button, a menu appears with some of the 
formatting tags that also appear on the toolbar, but if you just position the cursor in a color 
definition without selecting anything, the color selection dialog appears.

Now let's add an interesting graphic image for your page. Web Browsers use the background 
graphic as sort of wallpaper, i.e. they make repeated copies of the graphic to fill up the screen. 
Position the cursor as shown below:



<Body Background="|" BGColor=#FFFFFF Text=#000000 Link=#0000FF VLink=#FF00FF 
ALink=#FF0000>

Now look at the bottom of the screen. You will see a row of tabs that looks like this:

Each of these tabs launches a separate toolbar that can be placed in any convenient location. For 
this example, click Links/Graphics/Colors and then select EditImg from the toolbar that will 
appear.

WebThing will now ask you whether you want to save your file. This is a very good idea for 
several reasons. One reason is that you might otherwise lose your work in the event of a system 
crash or power failure. Another is that, if you locate your Web page in a particular directory, 
WebThing can automatically move all your resource choices to that directory also. This makes it 
very easy to move your completed Web page (or pages) to the Internet later on.

After you have responded to the Save-File dialog box, hopefully by saving your file, WebThing 
will ask you whether you want to automatically copy any files you select to this same directory. 
This is a good idea also, because (1) all your work will be located in one place, and (2) you are 
then allowed to use "relative links" to identify your resources, links that will work the same way 
no matter where you move your Web page.

These two dialog boxes are intended to guide you to a method that will seem desirable and 
obvious when you have had more experience.

Now navigate to a directory that contains some graphic files and select one. The two most-often 
used Web page file types are Graphic Image Format with the suffix .GIF, and Joint Photographic 
Experts Group (wow -- what a title!) files with the suffix .JPG. There are some others, but these 
are the best choices. If you don't have any graphic images with these formats, perhaps you have a
paint program (Corel Photo-Paint is one example) that can convert some of your existing images 
to one of these two formats.

Having selected a graphic image, you may once again see the result of your work by previewing.

By the way, if you make a change you don't like, you can undo it by pressing this toolbar button:

Now let's do some rudimentary formatting to improve the appearance of our page. Let's make 
two horizontal bars, one above and one below our typing. Position the cursor as shown below:

<Body Background="" BGColor=#FFFFFF Text=#000000 Link=#0000FF VLink=#FF00FF 
ALink=#FF0000>

|

This is my <B>first</B> web page!



</Body>

Now press the right-hand mouse button and select "Horizontal Rule" from the menu that will 
appear. Now the display should look like this:

<Body Background="" BGColor=#FFFFFF Text=#000000 Link=#0000FF VLink=#FF00FF 
ALink=#FF0000>

<Hr Width=80% Align=Center>

This is my <B>first</B> web page!

</Body>

Make another horizontal rule below your typing, so things look like this:

<Body Background="" BGColor=#FFFFFF Text=#000000 Link=#0000FF VLink=#FF00FF 
ALink=#FF0000>

<Hr Width=80% Align=Center>

This is my <B>first</B> web page!

<Hr Width=80% Align=Center>

</Body>

Now select the entire phrase "This is my <B>first</B> web page!", press the right mouse 
button, and select "Center" (there is also a toolbar button for this). Now look at your work in the 
browser.

Add paragraph breaks at the end of each line (some browsers will require this, some won't, but it 
is good HTML style). These are available from the right-click menu:

<Body Background="" BGColor=#FFFFFF Text=#000000 Link=#0000FF VLink=#FF00FF 
ALink=#FF0000>

<Hr Width=80% Align=Center><P>

<Center>This is my <B>first</B> web page!</Center><P>

<Hr Width=80% Align=Center><P>

</Body>

This is important to understand: Normal line breaks don't mean anything to HTML -- there has to
be an explicit tag that specifies a line break, such as <P>. There are two varieties of line break -- 
<P>, which separates paragraphs with a blank line( two line feeds), and <Br>, which provides a 



single break between lines (one line feed). Experiment with these and don't expect normal blank 
lines (with no tags) to appear in the Browser view.



Using WebThing

This section describes the general use of WebThing, and some of the ways you can make Web 
page creation easier.

To create a blank document, not necessarily an HTML document, press File … New Blank 
Document or press the corresponding toolbar button.

To create an HTML document that includes the basic structure of HTML, press File … New 
HTML Document. You will see the "Create HTML Document" dialog, which allows you to 
choose text and background colors and an optional background graphic as well as some other 
less-often-used options. You may also change these options after you have created the document 
by placing the cursor on the item of interest and pressing the right mouse button. You may then 
change the name of the background graphic or your color choices, as well as several other things.

To open an existing HTML document, select File … Open or press the corresponding toolbar 
button.

To save a document, choose either File … Save or File … Save as or press the corresponding 
toolbar button.

You may find and/or replace any text string you wish using either Edit … Find or Edit … 
Replace if you want to replace one text string with another, or the corresponding toolbar buttons. 
You can specify two non-printing characters using special symbols. The special symbols are ^p 
or ^j for line feed (the division between lines in a text editing document), and ^t for tab character.

You can Cut, Copy and Paste within or between WebThing documents and between WebThing 
and other Windows applications, although advanced features such as drag-and-drop are often 
easier to use.

You can test the result of your work at any time with up to six user-identified Web browser 
programs.

Beyond these normal behaviors, be sure to see Advanced Features of WebThing for some 
spectacular capabilities that will really make your Web Pages stand out from the crowd!



Advanced features of WebThing

WebThing has many ways to make your work easier. You may drag a selection from a Webthing 
document into another WebThing document and drop it at a chosen location, or you may drag a 
WebThing selection into another Windows application, or the reverse.

You can use the toolbar selections at the bottom of the main display to launch many independent 
toolbars that can be positioned in any convenient way. The toolbar selector bar looks like this:

Each toolbar contains a group of related functions. You should explore these toolbars to gain an 
understanding of their functions. 

Most of the commands related to these functions are reversible. If you don't like the outcome of 
your action, you may always undo it with the Undo command (control-Z) or toolbar button:

Some of the toolbar buttons allow you to redefine a file, link, or color. To use these buttons, 
position the cursor in the area on interest and press the appropriate button.

NOTE: Another way to accomplish this is to position the cursor and simply press the right mouse
button. In most cases WebThing will identify the target and launch the correct selection dialog.

In general, if you prefer to right-click the mouse, first position the cursor without selecting 
anything to let WebThing decide which action is appropriate, or select one or more characters to 
launch a menu of choices, or just use a toolbar function.

See also:

The Drag & Drop Mailbox



The Drag & Drop Mailbox

There are three ways to import a fully-formatted text block from another application, either 
formatted text, a table, or an indented outline:

(1) (the hard way) Drag the text from another application to WebThing and drop it where it is to 
go. Then select the inserted block. Then press one of these buttons on the Tables/Conversions
toolbar: Tab->Tbl for tables, Text->HTML for formatted text, or Outline->HTML for 
indented outlines.

(2) (easier) Use the File … Import functions to import Rich-Text formatted files which contain 
the formatted text of interest.

(3) (even easier) Use the Drag & Drop Mailbox (Edit … Open Drag & Drop Mailbox). Here is 
how:

· Drag the formatted text from another application and drop it into the blue window of the 
Drag & Drop Mailbox dialog. If you have done this correctly, the mailbox flag will pop up, 
indicating a successful delivery.

· Make sure the cursor is positioned correctly in the active document.
· Press one of the three buttons in the Drag & Drop dialog box, depending on whether your
formatted text is a table, formatted text, or an indented outline.

The Drag & Drop mailbox will automatically convert your text into HTML code, keeping fonts 
and font colors, sizes, styles such as bold, italic and other formatting, centered titles, and many 
other characteristics. It will create HTML tables from your tables, preserving styles as above. It 
will create indented outline-formatted lists, also preserving the formatting of the original 
document.

This means you can work in a full-featured word processing program of your choice, and, when 
you are satisfied with the appearance of your text, tables and outlines, just drag & drop them into
WebThing's Mailbox and press a button.

A special note about Table Formatting: In the standard Windows Drag & Drop export format, the
positioning of text within table cells is not preserved. Therefore, if you want to control the 
position of text within the table's cells, you must either:

(1) convert the table into a tabbed list in the word processing program and then select left, center,
or right positioning on a line-by-line basis before importing the table, or if this is not 
possible,

(2) Set the positioning within WebThing manually, after the table has been imported. In this 
example you want only the text in the middle cell of the row to be centered (you add the text 
in red):

<Tr><Td>data</Td><Td align=center>data</Td><Td>data</Td></Tr>



In this example you want the text of the entire row to be centered within the cells (you add the 
text in red):

<Tr align=center><Td>data</Td><Td>data</Td><Td>data</Td></Tr>

This is a feature that is supported in most modern browsers.

In recent releases of WebThing, you may convert a combination of formatted text and indented 
outlines by activating the Outline conversion option. This is more convenient than separately 
importing text and outlines.

The only exception to this convenient combination import is when the text paragraphs are 
themselves indented -- this confuses the import parser, which assigns bullets to each indented 
paragraph.



Custom Definitions

One of the tabs at the bottom of the screen is named "Custom." This function allows you to 
create your own commands. If you click the "Custom" selection and no definitions have been
made, you will see the "Custom Commands" dialog box. For each user-defined command, 
the dialog box allows you to choose:

· Index number (up to 32)
· Command (see below)
· Tool Tip Text -- this is the message that appears near a command button when you point 
the mouse cursor at it. This helps you remember the button's function.

The user-command entries may contain two special characters -- the reverse asterisk '`' which 
results in a line feed, and the vertical bar '|' which identifies the user's selection before the 
command is issued. For example, let us say that a new HTML tag is invented called the SHOUT 
and it has this syntax: <SHOUT>this phrase</SHOUT>. To define a command to handle this 
new tag, you would enter:

Index (choose an unused one)
Command: <SHOUT>|</SHOUT>
Tool Tip Text: "This is the new SHOUT Tag"

After you have entered this definition, a new command button will appear on the Custom toolbar,
and if you select a phrase and press the button, the tags <SHOUT> and </SHOUT> will enclose 
you selection.

The normal system-defined toolbar buttons work in much the same way -- most contain a tag 
description. You select a phrase or section you want to modify and press a button. The 
appropriate tag then encloses your selection.



The Right-Click Functions and Menu

When you are editing text, you may press the right mouse button to gain access to some special 
functions and a shortcut menu. Here is how:

To let WebThing choose the appropriate action, simply place the editing cursor at the desired 
location, without selecting anything, and press the right mouse button. If WebThing finds itself 
pointing at a color definition, the color dialog will appear. If WebThing detects a file name, a 
link, a resource, or one of many other things, the appropriate dialog box will appear, allowing 
you to make a new choice.

Example: if you position the cursor this way (the cursor is marked with the vertical bar character 
'|'):

This is a <Font Color=#FFF|F80>Color Block</Font> to emphasize it.

WebThing will detect the color definition and display the color dialog box. If you point at this:

<IMG src="book|case.jpg" alt="">

WebThing will open a "Change Graphic Image" dialog box, directed to the most recently 
accessed graphic file directory. In general, if you place the cursor on a color or a resource 
specifier string, WebThing will automatically sort out your intentions.

If WebThing cannot detect any of these things, or if you select some characters before pressing 
the right mouse button, a shortcut menu will appear which allows you easy access to many of the
most-used HTML tags.



The File Menu

The File menu has the normal commands for opening, saving, and closing documents, plus some 
special commands uniquely related to WebThing's purpose.

The New HTML Document command opens a document and the "Create HTML Document" 
dialog box, allowing you to customize the appearance of the HTML document. All the choices in
this dialog can be changed later.

The Save All Changed Files command simultaneously saves all open documents that have been 
changed in any way, with just one mouse press.

The Print command allows you to print your document, but not like a word processing program 
would, with page numbers and margin control. This command is primarily used to acquire a 
scratch-pad style hard copy for programming purposes. For more control of the printed output, 
transfer your document to a word processing program for printing.

The Import option allows you to import Rich-Text Formatted documents in Text, Table or 
Outline format (see Drag & Drop Mailbox for an easier way to import documents or selections).

The Custom Commands option allows you to import or export custom command definition sets. 
An exported command set is a tab-delimited database file with a header line, containing all the 
user-defined commands you have created. You can use these files to save commands by category 
or share them with a friend.

The Filenames to Lower Case command allows you to avoid one of the more irritating bugs that 
plague Web page development, that is, Windows 95 is not case-sensitive about file names, but 
the Unix servers where you post your Web pages are. A system of pages and resources may work
perfectly on your machine, then mysteriously not work when posted. File-name case sensitivity 
could be the reason. This command simply changes all your working directory's file names to 
lowercase.

For this command to work, you must have an open document that refers to the directory in 
question, not a blank or unsaved document. And (catch-22) the document you have open must 
itself already be lower-case, because the WebThing lowercase function can't rename open files.

You must also make sure that your documents have all lowercase references, because (once 
again) Windows 95 doesn't care about case, but Unix does. Get into the habit of using all 
lowercase resource references, and always consider this possibility first if you encounter 
mysterious behavior after you have posted your page.



The Edit Menu

The edit menu contains two commands to Undo or Repeat an action as well as the usual Cut, 
Copy, and Paste commands.

Undo works in an obvious way -- it simply copies the entire document into temporary storage at 
each issued command (not during keyboard text entries), and, if you decide you don't like the 
outcome of a command, you can simply undo it. If you don't like the undo, you can repeat the 
action. This method works because most Web pages are relatively short and therefore occupy a 
small amount of memory.

That's the good news. The bad news is, if you are working on large documents, you will run out 
of memory by using Undo. So you have the option of turning off this feature (see Setup Menu). 
if you find yourself running out of memory in seemingly normal circumstances, try turning off 
Undo.

The Find and Replace commands will search the entire document, or from the cursor to the end 
of the document if you have not selected any characters, or they will search the selection if you 
have. They accept two special characters that represent non-printing characters in your 
document: ^p or ^j represent a line feed, and ^t represents a tab character. This means if you type
'^p' (without the ' characters) as part of your entry, WebThing will search for line feeds (the 
character that separates lines in your document). The replace entry also accepts these special 
characters.

The Open Drag & Drop command opens the WebThing Mailbox. See Drag & Drop Mailbox for 
more information.



The Setup Menu

The setup menu takes care of several WebThing setup functions.

Default Font

Default Font allows you to choose a different font and size for the editing display. It also has a 
role in Drag & Drop processing. If you want to assure that the original text you are importing 
and the final display in your Web browser look as much as possible alike, then choose the same 
font and size in WebThing as you are using in the originating application. This also prevents 
unnecessary tags from being generated in the import process. If you see an extraordinary number
of tags in the final HTML document, specifying a font that should be obvious to both the 
application and to a browser, it is because WebThing is itself set to a different font or size than 
the application that created the document.

WebThing's import function also tries to maintain relative font sizes, but it does this by 
comparing the imported document's font sizes with its own default size. So choose a default font 
size in your originating application, and choose the same size in WebThing. This will minimize 
tag generation, and it will also assure that the HTML document you create will have the same 
relative font sizes as the original document (within the constraints imposed by HTML).

Also remember this. If the computer that reads your Web page doesn't have the font you have 
specified, the browser will use (1) a default font, or if it is clever (2) it will choose a font similar 
to the one you have specified. But don't expect great results if you use uncommon fonts, fonts 
not likely to exist on the receiving machine.

Activate Undo Feature

This function enables or disables the Undo feature. If you are experiencing out-of-memory errors
or are working with large documents, disable the Undo feature to conserve memory.

New Doc at Startup

This function chooses whether or not to open a new, blank document when WebThing runs.

Identify Browser

When WebThing is first installed on your system, it asks Windows if it knows the location of a 
browser. Normally this search is successful, but if not, the first time you issue the Preview 
command, from the menu or toolbar, WebThing will ask you to select a browser. The Identify 
Browser function allows you to select up to six browsers in the same way. These browsers can 
then be selected on the fly using Preview … Select and Launch Browser, which allows you to 
determine whether your Web page will look and function as you expect on several popular 
browsers.



The Tags & Tools Menu

Most of this menu is a duplicate of the functions offered by the Tab Bar Buttons at the bottom of 
the screen. It is mostly included for compatibility with keyboard-only operations (which I 
confess I haven't tried).

Also included on the Tags & Tools menu are commands to insert Date, Time and Both. There are
provided to allow you to date your Web Page revisions in a convenient way. The Date & Time 
command is also on the Right-Click Menu

At the bottom of the Tags & Tools Menu is a function named Cross-reference. This function 
requires that you have an open document on display from the directory in question. If this is so, it
creates a cross-reference table to show where each HTML page and resource is referenced. If 
there are any HTML documents or resources not referenced within the HTML document's link 
statements, they are marked with ***NONE*** in the list. This function allows you to identify 
resources that are not in use.

You have the option of listing all resource references, or only those resources with no references 
in the HTML documents.



The Preview Menu

The preview menu allows you to activate the selected browser, or quickly switch browsers. The 
Launch Selected Browser function is duplicated on the tooolbar.



The Window Menu

The Windows menu allows you to arrange opened documents in several ways. It also lists open 
documents and allows you to switch between them.



The Structure/Lists Floating Toolbar

This toolbar contains buttons for creating and modifying the basic structure of HTML 
documents. The DocStruct function opens a dialog box allowing you to choose various options 
such as background color, background graphic and so forth. Each of these options can be 
changed later if desired.

If you have already started the interesting part of your Web page but have forgotten to include 
the HTML outline or "wrapper," you can use this function to provide it. Simply select all your 
entries and launch this function. It will enclose your selection in the standard prefix and suffix 
tags, just as the normal WebThing tag functions do.

Two other intereresting functions on this toolbar are UnList, which provides a blank unordered 
list (otherwise known as a bulleted list) and OrList which provides a blank ordered list 
(otherwise knows as a numbered list). You simply fill in the values you want in the list. If you 
need more than the default four entries, just press the <Li> button on the end of the toolbar for 
extra entries.

The most exotic use of the unordered list in WebThing is as a structure for outlines. It turns out 
that HTML allows you to nest lists, so that each nested list is indented further than its parent list. 
So the Outline import function (see Drag & Drop Mailbox)takes advantage of this property to 
create multi-level outlines in HTML.



The Styles Floating Toolbar

The Styles toolbar provides easy access to many of the most often-used text formatting HTML 
tags. To use these functions, simply select the text you want to apply the command to, and press 
the appropriate button. WebThing will enclose your selection with the desired tags.



The Links/Graphics/Colors Floating Toolbar

This toolbar has functions for creating links to resources, other Web pages, graphic images, and 
colors. You have the option of creating a link and specifying what it points to, creating a blank 
link to fill in by hand, or editing the content of an existing link. Some of these functions are 
duplicated in a more convenient way in the Right-Click Functions and Menu.

The link functions NewLink and EditLink take advantage of a special Windows 95 file type. The 
file type has the suffix .URL, and it contains information about an Internet resource. When you 
browse the Web using Microsoft Internet Explorer, you may find something interestingand wish 
to save it. When you choose Add to Favorites, Windows 95 creates a .URL file for each site. 
Using NewLink and EditLink, you can read these files, and put the URL data in your Web page.

The NewImg, BareImg and EditImg functions work with graphic images. It is best to use 
the .GIF and .JPG file types -- these are the graphic file types likely to be compatible with the 
greatest number of Web Browsers.

The NewColor and EditColor functions change the color of a text selection. The EditColor 
function can be used in any situation where you can place the cursor in a previous color 
definition (although the Right-Click approach is in most cases faster and easier).

The DocLink and DocRef functions are special links that jump to a particular location in a 
document, including the one in which it is found.

This link reference:

<A href="#linkname" alt=""></A>

Will find this link name:

<A name="linkname"></A>

within the same document, and this link reference:

<A href="docname.htm#linkname" alt=""></A>

will find the same link name in another document.



The Tables/Conversions Floating Toolbar

Many of the functions on this toolbar are available in File … Import and the Drag & 
DropMailbox in easier-to-use forms. Using Tab->Tbl, Tbl->Tab, Text->HT and Outln->HT, you 
may import formatted Tables, Text, and Outlines. See Drag & Drop Mailbox for more 
information.

You may create an empty table with the Table function, if you just want a simple table to enter 
your own data. While entering data for such a table, you may want to add another row. Just press 
NewRow to accomplish this. You may also create a new row or data pair using <Tr> and <Td> 
respectively. This function remembers your choices for number of columns and rows.



The Fonts Floating Toolbar

This toolbar allows you to select a different font for your selection, or resize it in one of two 
ways. The Header-size way (using, for example, <H1>) sets an absolute size to your selection. 
The Font+n method increases the size of your selection relative to what preceded it. The second 
method usually produces the best results. You may enter any number for Font+n, the default 
buttons are merely the most common values.



The Forms/Misc Floating Toolbar

Much of this toolbar deals with an advanced topic: creating forms that interact with other 
programs using the CGI (Common Gateway Interface) protocol.

Form Functions

The NewForm function provides an outline of a standard form.

The Input function provides a dialog with selection of common input methods, that creates the 
desired input tags and/or tables.

The TextArea function provides a generic text input area for a form. You must provide 
information such as variable name and default value for this text area.

Miscellaneous Functions

The Marquee Function provides a moving marquee (supported only by the Microsoft Internet 
Explorer at the time of writing) of a text phrase you select.

The default behavior selection is alternate. Here are all the behaviors:

Behavior = Alternate. This makes your selection move back and forth, always in view.

Behavior = Scroll. Scrolls completely onto and then off the screen and then reappears on the 
opposite side.

Behavior = Slide. This makes the text scroll into view and then stop against the opposite margin.

Direction=Left or Right. This determines the direction of motion.

Bgcolor=#FFFFFF. This color choice, which can be edited using WebThing Color Editing 
features, determines the marquee's background color.

Loop=n or Loop=infinite. This determines how many times the marquee behavior repeats.

Scrolldelay=n. This determines the time, in milliseconds, of delay between redrawings of the 
marquee.

Scrollamount=n. This determines how much distance in pixels between each successive redraw.

There are several other less-often-used properties of the Marquee. Additional information can be 
obtained from Microsoft online at http://www.microsoft.com.

The Sound function creates a BGSOUND definition, and accepts your selection of sound file. 
Several sound file types are currently supported, but be sure to test your sound file on all 



available browsers.

The Import Text/Tables function launches the Drag & Drop Mailbox.



The Custom Commands Floating Toolbar

This toolbar carries out the commands defined by Custom Commands, and, if no commands 
have been defined, launches the Custom Commands dialog box.



Autocopy Mode

WebThing takes care of a difficult issue in Web page development automatically. This feature, 
called Autocopy, allows WebThing to automatically copy your resource selections to your 
working directory. This has two effects:

(1) All the selected resources for your page end up in one directory. This is a reliable way to 
maintain control over those resources.

(2) Because all the resources are in the same directory as your Web pages, you may use relative 
links instead of absolute links. This is a way to make your pages more reliable and more 
portable, because you can move the entire package to any site and it will work as intended.

Instead of a link that, because it is located in another directory, looks like this:

<IMG SRC="c:\data\network\mywebpage\mypicture.gif" >

, using Autocopy, yours will look like this

<IMG SRC="mypicture.gif" >

because the resource is located in the same directory as the page that refers to it.

The Autocopy mode requires that two conditions be met:

(1) You must choose a working directory for your HTML pages, and
(2) You must enable Autoocopy when WebThing asks you to.

The first time you try to attach a resource file to your page, if you haven't yet saved your Web 
page, WebThing will ask you if you want to save it. If you respond with Yes, (highly 
recommended) then WebThing will ask whether it can enable Autocopy.

After Autocopy has been enabled, no matter where you find your resources, they are copied into 
your working directory and their names are converted to the relative form.

The best part of Autocopy is that, when you have created and tested your Web page(s) at your 
personal computer, you can upload the entire package to your Internet Service Provider and    it 
may work perfectly the first time. This is not an everyday occurrence.

A final problem may be overcome by converting all your file names to lowercase, to conform to 
the case-sensitivity of Unix servers. See more on this subject in The File Menu description.



CareWare - What is it?

WebThing is one example of a new software distribution system developed by the author. In the 
CareWare system, you don't owe any money to anyone. By the way, if someone made you pay 
for WebThing, you were cheated. You should go back and demand a refund. WebThing is freely 
available on the Internet and, because I own the copyright, no one has the right make you pay for
it except me, and I'm not going to.

But you are not off the hook yet. The "Payment" for a CareWare program is not monetary. You 
have to make a different kind of payment altogether. Let me explain.

Most Americans are totally dissatisfied with everything. It is too hot, too cold, too wet, too dry. If
we have a free day, we are unhappy because we don't have two free days. And just about the time
we figure out that we are supposed to appreciate the world as it is, we fall over and die.

So here's your payment for WebThing:

Imagine you have only two hours to live:

Is there something important you have to say to someone, something you might regret not
having said? If you were to die, would that person always wonder what you really 
thought or felt?
Is there a pretty spot you have always wanted to visit, sit under a tree, whatever?
Have you ever experienced the shock of noticing how beautiful ordinary things are, once 
it dawns on you that you might not be around very long?

If you are an old person (like me):

Do you speak to young people in a way that they will be encouraged to grow up and 
expect to be happy and productive?
When you correct a young person, do you ask yourself    "Is this mostly for my benefit, or
mostly for his?"

If you are a young person:

Do you try to be patient with old people, even though most of us are complete morons?
Do you try to live in the world as though you belonged here, as though what you do 
matters to everyone, to the world itself, to you?
Do you appreciate the small, free beauties of life, and not expect to buy anything very 
important?

Look at this list. If you already belong to this list, if this list already reflects your behavior and 
values, then you already own your copy of WebThing. In a sense, you owned it before it was 
written.

If you don't feel a kinship with the statements in the list, then please do one or more of the things



listed there. Maybe change how you talk to a young person, or someone whose life would be 
improved if you related to him or her differently. Or just allow a sense of wonder to re-enter your
life, a sense that nothing is deserved and everything contains hidden beauty. And that sometimes 
beauty is not so much hidden as unobserved.

I would like it if you lived your entire life as though each day was your last, as though every 
small action mattered, in the way that it does when you've run out of time. But I am a realist -- if 
you do that for just one day, one day of saying the important things, of performing the 
kindnesses that naturally occur to us when each day might be our last, then you will have paid 
me for WebThing.

I don't ask this because there is some definition of good behavior, some correct religious or 
philosophical viewpoint. I ask it precisely because there isn't such a viewpoint. We are all free 
agents, we get to choose. In fact, we must choose -- it's dangerous to let others choose for us. 
And no one gets to tell anyone else how to behave -- unless, of course, one is "selling" software 
using the CareWare system.

Paul Lutus, Ashland, Oregon



WebThing Distribution Policy

WebThing may be freely distributed and copied, so long as no fee is charged. WebThing may not
be made part of a product for which a fee is charged.

Notwithstanding the foregoing, WebThing is not in the public domain and is © Copyright 1996, 
Paul Lutus, who retains all present and future rights in and to WebThing.

The determination of fitness of WebThing for any particular purpose shall be solely with the 
recipient, and Paul Lutus shall not be responsible for any damages, direct, indirect, or 
consequential, that may arise from use of WebThing.



HTML (Hypertext Markup Language) is the language with which Web pages are written. 
Originally invented by Tim Berners-Lee while at CERN, HTML is undergoing changes and 
improvements as time passes.



Browser: a generic term used to describe a program that can read and display Web Pages. 
Examples: Netscape, Microsoft Internet Explorer.



Web: a slang term for the Word Wide Web, the interacting entity composed of the Internet, 
HTML pages posted there, and browsers.



Web Page: A document written in HTML, that allows one to interactively gain access to other 
resources by way of active links.



Internet: A worldwide network of computers and people.



Unix: a very popular computer operating system. Much of the present ability of Windows and 
other similar operating systems was derived from Unix. Unix allows multiple users to run 
multiple processes on a single computer, and facilitates interconnection between computers.



Object: In computer parlance, an object is a package consisting of (1) data and (2) computer 
program elements designed to act on the data.



Hypertext: a scheme by which one can navigate through an information resource by activating 
links.



No, no. Don't confuse this with REALITY. This is WINDOWS. Reality requires a Browser.



Telnet: an older Internet communication protocol that resembles a text editor screen, except that 
you can issue commands to a remote system in what is called a "Unix shell session."



Internet Service Provider: A company that provides Internet access to individuals and businesses.
Most good providers allow several megabytes of storage on their server per subscriber, thus 
allowing one to post a Web page with plenty of graphic images and other resources.



Relative Link: a Web page link that presumes that its target is a local resource, rather than 
spelling out exactly where it is located. Also see Absolute Link.
Relative Link: <IMG SRC="mypicture.gif" >
Absolute Link: <IMG SRC="c:\data\network\mywebpage\mypicture.gif" >



Absolute Link: a Web page link that presumes that its target is not a local resource, therefore 
spelling out exactly where it is located. Also see Relative Link.
Absolute Link: <IMG SRC="c:\data\network\mywebpage\mypicture.gif" >
Relative Link: <IMG SRC="mypicture.gif" >



Tag: a term used in HTML programming to describe the fundamental unit of communication 
between the HTML script and the browser that tries to read it. Example: in an HTML script, 
"This is <I>very</I> important" will be shown by a browser as "This is very important" because 
the browser understands "<I>phrase</I>" to mean "Italicize all between <I> and </I>."



 Rich text Format: a file format supported by many Microsoft applications that preserves the 
appearance of the document, but can be easily transported to another application. WebThing 
supports Rich Text Format.



 Hyperlink or Link: a reference in a Web Page that refers to another Web page or some other kind
of resource. When you click on the link, you jump to what the link describes. Also see Absolute 
Link, Relative Link.



Select, Selection: A method to choose a part of a document. You most often select text in one of 
these ways: (1) hold down the shift key while moving the cursor across the desired text with the 
arrow keys, or (2) press the left mouse button and drag the mouse cursor across the desired text.



Pixel: Short for Picture Element. One of the matrix of graphic elements that make up a graphic 
image. A 640 by 480 VGA graphic image has 640 horizontal pixels per row and 480 vertical 
pixels per column, for a total of 30,720 pixels. Pixels are the basic units out of which graphic 
images are created -- each displays a color dot.




